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User’s Guide for MapIMG 2: Map Image Re-projection Software Package

By Michael P. Finn, Jason R. Trent!, and Robert A. Buehler*

Version History

Version 0.0  Dan Steinwand, U.S. Geological Survey (USGS)/Earth Resources
Observation Systems (EROS) Data Center (EDC) 1995
Version 0.0 was a command line version for UNIX that took four arguments: the
input metadata, the output metadata, the input data file, and the output destination
path.

Version 1.0  Stephen Posch and Michael P. Finn, USGS/Mid Continental Mapping
Center (MCMC) 2003
Version 1.0 added a GUI interface that was built using the Qt library for cross
platform development.

Version 1.01 Jason Trent and Michael P. Finn, USGS/MCMC 2004
Version 1.01 suggested bounds for the parameters of each projection. Also, it added
support for larger input files, storage of the last used input and output folders, and
support for TIFF/GeoTIFF input images.

Version 2.0  Robert Buehler, Jason Trent, and Michael P. Finn, USGS/National
Geospatial Technical Operations Center (NGTOC) 2005
Version 2.0 added Resampling Methods (Mean, Mode, Min, Max, and Sum), updated
the GUI design, and added the viewer/pre-viewer. Also, it changed the metadata style
to XML and switched to a new naming convention.

! Now with the University of Missouri — Rolla, Department of Computer Science.



Preface

Significant changes for version 2.0 include a new user interface to be more similar to
standard window applications, a viewer to show loaded files and preview re-projections,
different resample methods beyond nearest neighbor, and XML files (a popular ASCII
file structure for containing structured information) as the new format for the metadata
files.

Author, fill value, and no data value information have been added to the metadata file
(see General Input Information for additional details). A naming convention also has
been selected such that MapIMG is the new spelling; it will no longer be referred to as
mapimg.

MapIMG 2 supports more projections than were supported in MapIMG v1.01, but a few
still remain unsupported. However, the control has now been given to the user to run
these special projections at his or her risk. Certain projections are marked with a “Bad
Projection” tag as shown in figure 1.

Map | Projection

5
Polar Stereographic

Bad Projection: This projection

either generates useless data or
D'DDDDDDDcrashes. It is recommended that wou

choose a different one. This issue

may be addressed in Future versions

0.000000005F mapirng.

0.000000

1.000000

Figure 1. Bad Projection Tag

If the user attempts to continue with this projection, an error message will popup

(figure 2). By clicking “Ignore” the user can continue and MapIMG will attempt to
perform the re-projection. More often than not this course of action will result in a map of
zero size, large amounts of extraneous data, or a crash.

&% Bad projection parameters ll

Polar Stereographic is an unsupported projection at this time.
-The framing generates huge walues For rows and cols.

Ignore |

Figure 2. Bad Projection Parameters Error Message

This feature should be quite useful if the user is a developer/programmer that is
attempting to tweak a “Bad Projection.” An example would be working with the Polar



Stereographic projection. MapIMG transforms points near the opposite pole to be at or
near infinite. If the developer re-programs MapIMG to skip points within 10 degrees of
the opposite side, then running the projection would require choosing “Ignore” as
opposed to finding and altering the code that labels Polar Stereographic as a “Bad
Projection.”

It should be noted that currently, MapIMG only supports raster datasets of global extent;
therefore, calculated values only will be valid if the input is truly to a global extent.

While this user’s guide does make reference to previous versions, it also is complete for
the current version of MapIMG. All features of the MapIMG 2 software package are
explained in this document.



Background

Scientists routinely accomplish small-scale geospatial modeling in the raster domain,
using high-resolution datasets for large parts of continents and low-resolution to high-
resolution datasets for the entire globe. Direct implementation of point-to-point
transformation with appropriate functions yields the variety of projections available in
commercial software packages, but implementation with data other than points requires
specific adaptation of the transformation equations or prior preparation of the data to
allow the transformation to succeed. It seems that some of these packages use the U.S.
Geological Survey’s (USGS) General Cartographic Transformation Package (GCTP) or
similar point transformations without adaptation to the specific characteristics of raster
data (Usery and others, 2003a).

Usery and others (2003b) compiled and tabulated the accuracy of categorical areas in
projected raster datasets of global extent. Based on the shortcomings identified in these
studies, geographers and applications programmers at the USGS expanded and evolved a
USGS software package, MapIMG, for raster map projection transformation (Finn and
Trent, 2004). Daniel R. Steinwand of Science Applications International Corporation,
National Center for Earth Resources Observation and Science, originally developed
MapIMG for the USGS, basing it on GCTP. Through previous and continuing efforts at
the USGS’ National Geospatial Technical Operations Center, this program has been
transformed from an application based on command line input into a software package
based on a graphical user interface for Windows, Linux, and other UNIX machines.

MapIMG 2 is now on the Web with the User’s Guide, source, and binaries available for
download at:
http://carto-research.er.usgs.gov/projection/acc proj data.html




General Input Information

Generic Binary Raster Image

The primary file type of MapIMG is a Generic Binary raster file. MapIMG uses - img as
the extension for these files. They contain no header data. The file is composed entirely
of values for cells sorted in row major order. Currently, MapIMG can manipulate and
view files with any one of a number of data types used to store the values. These data
types are unsigned or signed, 8, 16, or 32 bit integers, and 32 or 64 bit floats. Single-
image tagged image file format (TIFF) or GeoTIFF files also may be used as input;
however, it is highly recommended that all images be exported to Generic Binary if at all
possible.

If TIFF/GeoTIFF images are used, they are exported to Generic Binary format as soon as
they are loaded. The TIFF format stores images as 32-bit color values, which are then
extracted to Generic Binary. It is recommended that TIFF input be used only for thematic
data; continuous data will lose all actual values and only relative values will remain.

Band interleaved by line (BIL) is a storage format for image data. For a single band of
data, BIL is the same as band sequential (BSQ) and band interleaved by pixel (BIP)
(Slater, 1980). Generic Binary, as used in MapIMG (consistent with ERDAS Imagine), is
any of these single-band formats that store data in a left-to-right, top-to-bottom row order
(ERDAS, 1999). It allows for varying data types—for example, from 8 to 64 bit.

CAUTION: The Generic Binary file must use the same byte ordering (endian) as the
computer running MapIMG. The file is a raw image with absolutely no metadata, not
even the dimensions of the image, which must be known by the user. The output also will
be in the same raw format.

A common naming convention is recommended to keep track of files: in particular, the
format (type)_(proj)_(pix_size).img, where type is the type of data (theme) being used,
proj is the projection used, and pix_size is the output file’s pixel size. For example,
glc_sine_30sec.img would be used to represent a global land cover image in the
sinusoidal projection with a pixel size of 30 arc-seconds. Notice that the file name always
ends in .img, signifying a generic binary image. Although these conventions are not
mandatory for proper program execution, they provide a useful and reliable way to keep
track of files.



XML Metadata

Anytime MapIMG is executed on a file, an associated XML file (figure 3) will be created
from the parameters selected by the user for both the input and the output image. For an
input/output file called file_name.img, the associated XML file will be named
file_name.xml. It is not absolutely necessary to save these files, but it is highly
recommended. If the input/output files are to be used again in the future, the XML files
will make sure the correct projection parameters are used.

<7xml wersion="1.0" standalone="yes" 7=
- <rasterInformation =
+ - e
- «authors
<name=mapimg user</name =
<company=U.8, Geological Survey</company =
<email=mapimg@usgs.gov-</email >
<fauthor=
- «areax
<ulCaorner ulx="-19987278.643587" uly="9979739.958201" /=
<dimensions rows="360" columns="720" /=
<farea=
- <pixelDescription =
<sign=unsigned-=/sign=
<hits =8</bits =
<type>Integer=/type=
<pixelSize=>55597. 454840« /pixelSizex
<fillvalue=32.000000=fillValue=
<noDatavalue=Undefined</noDatavalue=
=« pixelDescription =
- =projection number="17"=
<name =Equirectangular</name=
<zone=6B2Z2</zonex
<daturm number="19"=Sphere of Radius 6370997 meters</daturm =
<units number="2"=Meters</units =
=/ projection =
< GCTPParams=
= |-~ -
<param=6370997.000000«parar =
= |-- -
<param=0.000000</param =
= |-~ -
0.000000

Figure 3. Sample XML File



Parameter Descriptions
Rows and Columns define the pixel dimensions of the generic binary raster image.

Upper Left (UL) Coordinate is the measurement, in meters, that anchors the upper left
corner, the “first cell”, of the image. The “first” cell is usually located at 90° N 180° W
(as in this implementation for global map projections). It is measured from the location
of the “center” cell of the image (raster file) that is generally located at 0° latitude 0°
longitude, but can be anywhere the mapmaker defines it. The UL latitude measurement
is the number of meters from the “center” cell to the “first” cell in the northward
direction. Likewise, the UL longitude measurement is the number of meters from the
“center” cell to the “first” cell in the westward direction. Figure 4 pictorially depicts the
previous statements.
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Figure 4. Cell Reference

Units define the units of measurement for each of the parameters. Currently only meters
are supported. If changing units is supported in the future then it would be possible to
enter parameters such as the upper left coordinate in units other than meters.

Spheroid defines the shape of the earth for use in the projections. This is another
parameter that cannot be adjusted at this time. Only a spheroid of radius 6370997 meters
currently is supported.

Pixel Size describes the width and height in meters of a pixel at the point of true scale in
the image.

Pixel Data Type describes the way each pixel’s value is stored in the image file.
(e.g. 8 Bit Unsigned Integer and 32 Bit Float)

Fill VValue is the numeric value that MapIMG places in areas that are not part of the map.




No Data Value is used to determine places in a map where no data are present. This
value never occurs outside the map where fill value would be placed. It is used by
MapIMG for resampling methods where the sample being pulled from the input is full of
ignore values.

Ignore Values are entered on the resample form in a list at the same time that the
parameters for the output image are changed. All values listed will not be used in
calculations during the resample. That is, they are not part of the re-projection, but are
there only so there will be no holes between pixels inside or outside the map frame. The
no “data value” and “fill value” also are ignored.



Running MapIMG

MapIMG is a stand-alone program available for Windows, Linux, and Solaris. All images
in this guide are of the Windows version, but other versions will look similar. Double
click the MapIMG executable (mapimg2 . exe) to begin execution of the program.

Opening MapIMG 2 for the First Time
The first time MapIMG 2 is run, the Author Properties dialog will appear as shown in
figure 5.

&% Author Properties x|

Figure 5. Author Properties Dialog

After entering a name, company, and email address, click “Ok” to save them and
continue. Clicking “Cancel” will continue without saving. The MapIMG main dialog
shown in figure 6 will appear, and MapIMG is ready for use.

=lolx|

File ©ptions Preview Tools Help

ErE1IEOE0Y]

Frojection |

Figure 6. MapIMG 2 Main Dialog
If at any time the author fields need to be changed then choose Options - Edit
Author (Ctrl+A) to display the Author Properties dialog (figure 5).



Actions Overview

Toolbar Buttons

3

Open: Pressing this button displays the open file dialog and allows the user to select an IMG or
TIFF file and load it as input.

Re-project and Save: Assuming all parameters are filled and error free, pressing this button
will display the save file dialog and allow the user to select a destination for their re-projection
and specify resampling options.

Show Input Parameters: Pressing this button toggles whether the green panel for input
information is shown or not.

Show Preview: Pressing this button toggles whether the preview panel is shown or not. Also, if
the user clicks on the down arrow then they can select to show input or output previews.

Show Output Parameters: Pressing this button toggles whether the red panel for output
information is shown or not.

Resample: Pressing this button will resample the viewer to the current resolution.
(See “Using the Viewer”: page 17)

Preview Re-projection: Pressing this button will hide the input parameters and show the
preview panel with a small scale version of what the re-projection will look like.

Parameter Buttons

Lock and Unlock: This button is present on the input parameters and allows the user to unlock
and edit them. By re-locking the input the parameters are auto-saved.

Calculate: Pressing this button will update the rows, columns, and upper left coordinates with
their values based on the GCTP calculations using all projection info and the pixel size.

Copy from Input: Pressing this button will copy all the values from the input list to the output
list. This is a quick way to make minor adjustments to a projection.

Other Actions

H

Save Input Parameters: This action is redundant to locking the input parameters. It will save
the parameters in the list if they are valid and prompt if a file is about to be overwritten.

O
PRI E it Author: Choosing this action will re-show the Author Properties dialog (figure 5) so that
Mo the user can change their author parameters.
Tools
Decision Support System: This action launches the current machine’s default browser to the
Menn USGS website hosting the Decision Support System for Map Projections of Small Scale Data.
Help
! About MapIMG: Choosing this action will show the About MapIMG dialog that contains a
Men brief disclaimer, contact info, and a credits section for libraries used.
Help

Menu

About Qt: Choosing this action will show the About Qt dialog as per request by Trolltech, the
authors of Qt.

EAIT

Exit: This action will immediately exit MapIMG.
Do not pass GO and do not collect $200.
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Re-projecting

The first step in performing a re-projection is to load the desired input file to re-
project. This is done by clicking the Open button (=), choosing File > Open..., or
pressing Ctrl+O. An Open File window (figure 7) will open that is used to select an

IMG (generic binary) or TIFF file.

Choose an image

21|

Laok jn: | {3l IMG Files

R e = s

glc_generalvertical _30sec.img
glc_geographic_30sec.img

E glc_mollweide_30sec.img
glc_orthographic_Smin.img
haldnorm_albersEqualarea_30min.img
haldnorm_azimuthal_30min.img
holdnorm_equidistantconic_30min.img
haldnorm_genvertnearper _30min.img
holdnorm_geographic_30min.img
haldnorm_hammer_30min.img
haldnorm_hatine_S0min.img

4 |

haldnorm_interruptedgoode_30min.img
holdnorm_inkerruptedmolhweide_30min.im
haldnorm_lambert azimuthal _30min.img
haldnorm_mercator_30min.img
haldnorm_rmercator-sin_30min.img
haldnorm_millercylindrical _30min.img
holdnorm_mollweide_30min.img
haldnorm_orthagr aphic_30min.img
holdnorm_orthogr aphicLARGE_30min.img
haldnorm_robinson_30min.img
holdnorm_spacecblique_30min.img

i

File name:

Iholdnorm_geographic_3Dmin.img

Open |

Filesof type:  [MapIMG Files [*img)

Lef Lo

Cancel |

7

Figure 7. Open File Dialog

Click “Open”, if the selected file has an associated XML file, it automatically will be
loaded (figure 8). Otherwise, the input parameters must be entered as outlined in

Modifying Input Parameters.

Figure 8. Loaded Input Parameters
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Next, the output parameters need to be set (figure 9). Again, this procedure is outlined
in Modifying Output Parameters. This process is streamlined by the “Copy from
Input” button (“8). If the red output parameters are not visible, click the “Show
Output Parameters” button (£).

Frojection

30 Minutes

Figure 9. Edited Output Parameters

Once all the parameters have been set, click the “Re-project and Save” button (ls),
choose “File” > “Re-project and Save”, or press Ctrl+S. Assuming there are no
errors or warnings for the parameter choices, the next window shown should be a
“Save File” dialog (figure 10). This window is used to select the destination and name
for the new file created after re-projecting. If “.img” is not typed in to the “File
Name” field then it automatically will be appended. Click “Save” to continue.

Choose a destination for the reprojection I
Save in: | (=4 IMG Files x| & 5k El-
glc_geographic_30sec.img &| holdnorm_interruptedmollweide_30min. i
glc_mollweide_30sec.img @ haldnorm_lambert azimuthal _30min.img
glc_orthographic_Smin.img E haldnorm_rmercator _30min.img
haldnorm_albersEqualarea_30min.img E haldnorm_rmercator-sin_30min.img
holdnorm_azimuthal _30min.img E holdnorm_millercylindrical _30min.img
haldnorm_equidistantconic_30min.img E haldnorm_rmollvweide_30min.img
haldnorm_genvertnearper_30min.img @ holdnorm_orthagr aphic_30min.img
haldnorm_geographic_30min.img E haldnorm_orthogr aphicLARGE _30min.img
haldnorm_hammer_30min.img @ haldnorm_robinson_30min.img
holdrorm_hotine_30min.img E holdnorm _spaceoblique_30min.img
haldnorm_interruptedgoode_30min.img E haldnorm_transversemarcator _30min.img
gy [ | b
File name: }'u:nln:lru:urrn zinusoidal_30mir.img j Save I
Save as type: IMapIMG Fiaster Files [*.img] j Cancel |
7

Figure 10. Save File Dialog
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The next window to appear is the “Resample Options” dialog (figure 11).

#%Resample Options x|

Figure 11. Resample Options Dialog

After clicking “OKk” the re-projection begins. A progress bar (figure 12) is shown,
which allows the user to abort the process. The re-projection is complete once the
progress bar reaches 100%. If it reaches this point without the user pressing “Abort”
then a “Completed” message box will be show (figure 13).

#% Completed x|

= processing.. T

(LTI
-

Figure 12. Re-projection Progress

Figure 13. Completed Message Box

By clicking “View Log” the user is shown the MapIMG Log dialog (figure 14),
which can be used to save the shown log of the re-projection to a text file.

22 MapIMG Log... x|

SINUSOIDAL PROJECTION PARAMETERS:

Radiuz of Sphere:  B370997.000000 meters
Longitude of Center:  0.000000 degrees
Falze Easting:  0.000000 meters

Falze Morthing:  0.000000 meters

EQUIRECTANGULAR PROJECTION PARAMETERS:

Fadiuz of Sphere:  B370997.000000 meters
Longitude of Central Meridian:  0.000000 degrees
Latitude of Ongin: ~ 0.000000 degrees

Falze Easting:  0.000000 meters

Falze Morthing:  0.000000 meters

M apltG haz completed

Output Rows: 360

Olutput Columng: 720

Figure 14. MapIMG Log Dialog

13



Modifying Input Parameters
The first time a file is loaded, or if the paired XML file becomes corrupt beyond recovery
the message shown in figure 15 will appear. If a valid XML file was found, the values

will be loaded. Press the lock/unlock button (&, &) to change to the unlocked state and
then proceed to change parameters as normal.

% 0pen x|
i D fimages. xml
ML Fils carrupted or nat Found,
Please use the Input Info Editor ta define the map and projection parameters,

-The lock button saves changes.
~The caleulator button Figures out the rows, columns and upper left coordinates.

Figure 15. Missing or Corrupt XML

(1) Setup the “Projection” parameters

a.
b.

C.

Select the “Projection” tab.

Select the projection for the input file from the “Projection” drop down
menu.

The area below the “Projection” drop down menu will change to reflect
the parameter relevant to the selected projection. Make all changes
required to correspond to the input image. This may include “Radius of
the Reference Sphere”, “Longitude of Central Meridian”, “Latitude of
True Scale”, “False Easting”, “False Northing™, or other relevant
parameters.

(2) Setup the “Map” parameters

a.
b.
C.

Select the “Map” tab.

Select the “Pixel Size” from the “Pixel Size” drop down menu.

Manually enter the number of “Rows of Pixels”, “Columns of Pixels”,
“Upper-left Latitude in meters”, and “Upper-left Longitude in meters”, or
press the “Calculate” button (&) to calculate these parameters based on the
chosen pixel size and projection.

Note: Currently MapIMG only supports raster datasets of global extent;
therefore, calculated values only will be valid if the input is truly to a
global extent.

Select the pixel data type of the input file from the “Pixel Data Type” drop
down menu. An incorrect data type will not only produce incorrect results,
but also may cause instabilities in the MapIMG itself.

If the input image has a frame around it check the “Fill VValue” check box
indicating that a “Fill VValue” is present. Then, enter the value in the “Fill
Value” edit box.

If the input image has a value corresponding to areas where data are
unavailable, check the “No Data Value” check box. Then, enter this value
in the “No Data Value” edit box. An example of this may be a population
dataset where areas with an unknown population have a set value, -1 for
instance.

To save the XML file corresponding to the input image press the
lock/unlock button (&) or choose File > Save Input Parameters. If the

14



lock/unlock button is used the icon should change from unlocked (& ) to
unlocked (&) and the parameter fields will become read-only and a
prompt will ask for confirmation that you want to same the input
parameters. This indicates a successful save of the XML file.

Modifying Output Parameters

Once the desired input file has been loaded and its parameters configured the next step is
to set up the output projection information. It is suggested that the Copy from Input
button (*2) is used. This will copy all of the parameters from the input to the output. Once
this is done, only the parameters to be changed will require user interaction. “Pixel Data
Type” is set by the input “Pixel Data Type” and cannot be altered.

(1) Setup the “Projection” parameters

a. Select the “Projection” tab.

b. Select the projection that the input file represents from the “Projection”
drop down menu. Remember to check for the Bad Projection tag (figure 1)
before continuing. If the tag is present, MapIMG may become unstable or
produce invalid output if the output projection is used. A link to the
Decision Support System (DSS) for Map Projections of Small Scale Data
is provided to assist in selecting an appropriate projection. The link is
available under “Tools” = “Decision Support System”. It will attempt to
load the default browser of your operating system to the following
address: http://mcmcweb.er.usgs.gov/DSS/ .

c. The area below the “Projection” drop down menu will change to reflect
the parameter relevant to your selected projection. Make all changes
required to correspond to your input image. This may include “Radius of
the Reference Sphere”, “Longitude of Central Meridian”, “Latitude of
True Scale”, “False Easting”, “False Northing”, or other relevant
parameters.

d. Make note of any field with an asterisk (*) next to the parameter label.
These parameters have additional constraints that should be taken into
account before continuing. Placing the mouse cursor over the label for a
few seconds will produce a tool-tip with additional information about the
particular constraints of that parameter.

(2) Setup the “Map” parameters

a. Select the “Map” tab.

b. Select the pixel size from the “Pixel Size” drop down menu.

c. Press the Calculate button (Z) to calculate “Rows of Pixels”, “Columns of
Pixels”, “Upper-left Latitude in meters”, and “Upper-left Longitude in
meters” based on the chosen pixel size and projection.

Note: Calculated values are for a global extent only.

d. If the input image has a “Fill Value” the output “Fill Value” will be the
same, and may not be changed. This prevents having multiple different
framing values in the same file. If the input does not have a “Fill Value” it
can be manually entered or the “Recommend Fill Value” button can be
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pressed to generate a new “Fill Value”. This is done by taking a small
sample of the image and adding two to the maximum value encountered.
e. If the input image has a “No Data Value” the output “No Data Value” will
be the same, and may not be changed. This prevents having multiple
values indicating where no data are available. If the input does not have a
“No Data Value” you may check the output “No Data Value” check box
and manually enter a value in the output “No Data Value” edit box.
Note: A No Data Value is required if Ignore Values are going to be used
during the resample process (see Choosing Resample Options).

Choosing Resample Options

After the output file location has been chosen using save and re-project, the next step is to
choose the resampling options. At any point, the cancel button may be clicked to end the
re-projection process, and the ok button may be clicked to continue on to the re-
projection.

(1) Choose the resampling method
The available options currently include “Nearest Neighbor”, “Sum”,
“Mean”, “Median”, “Mode”, “Min”, and “Max”. As the method is
selected, text under the choice will change to provide a note on this
resampling methods performance in categorical vs. continuous data.

(2) Enter all ignore values into the list
The ignore values section (figure 16) has, in the upper left, a text box for
entering values. Once the value is fully typed it can be added to the list by
clicking “New Value”. Pressing enter while typing in the text box will
have the same effect. Values can be removed from the list by selecting
them with the mouse in clicking “Delete Value”. All values entered are
forced to conform to the pixel data type as defined in the input parameters.

lgrare ' alu

Jo
Mew Value - |
[ 2zt Szl 4 |

—Memon Allocation

Figure 16. Ignore Values Section

(3) Adjust memory allocation
Allowing for a larger line cache by increasing the memory allocation can
speed up the re-projection and improve accuracy in the sum resampling.
This memory is used to store lines of the input image. If a pixel value is
needed from the input on a line that was accessed before, it would be
much faster to access it if it was still located in memory; a large line cache
will improve the chances of that happening. The sum resampling method
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marks pixels in the allocated cache that have been used in the output. If a
line is pushed out of the cache and then called upon later, the values may
potentially be counted twice.

The “Default” value is 100 lines, and the minimum is the ratio of output
lines to input lines plus 2 percent of the output lines.

Using the Viewer

When the viewer is shown with the “Show Preview” button (&) it will display a USGS
logo by default. Once an input file has been loaded the viewer will be forced to input
mode and loading of the preview will begin. This process is completed in two progress
bars. The first one is creating a color table by sampling the file, and the second one is
loading values from the file and drawing them into a picture. Once they are both
complete, the preview image will be displayed.

The preview panel will stretch to fill the MapIMG window. As the window is resized its
boundaries will change and the preview picture within will be stretched to maintain the
original aspect ratio and moved to stay centered in the panel. The image previewed is a
down-sampled image using nearest neighbor. Therefore, when the image is stretched, the
individual pixels become larger without resampling the file. Once a new size for the view
is determined, the “Resample” button (&) can be clicked and MapIMG will resample the
file at the current resolution to produce a higher quality image.

Note that the “Show Preview” button has a down arrow on the lower right corner.
Clicking and holding on this arrow will show a popup menu allowing the user to switch
between “Preview Input” and “Preview Output”. Choosing preview output is similar to
pressing the “Preview Re-projection” button (& ). The preview panel will be displayed
and four progress bars will complete in the process. The first one represents the down-
sampling of the original image to a much smaller size. The second one is a fast re-
projection to a low resolution version of the output projection parameters. The final two
progress bars are the color table generation and value loading as outlined previously.

Other Tools

Currently, the only extra tool with MapIMG is the Decision Support System for Map
Projections of Small Scale Data (DSS). A link is available under “Tools” = “Decision
Support System”. It will attempt to load the default browser of your operating system to
the following address: http://mcmcweb.er.usgs.gov/DSS/ . A user’s guide is available
for the DSS and is available at http://carto-
research.er.usgs.gov/projection/pdf/DSS_User_Guide.pdf .

Troubleshooting
Error, missing or malformed <___ >tagunder <__ >.
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XML File corrupt or not found.
These errors occur when there is an issue with the .xml metadata file. The solution is to
use the input parameter editor and save changes by using the lock button (&).

Tiff Image — Conversion failed for unknown reason.
The Tiff library couldn’t open the chosen Tiff file. Make sure the file pointed to ends in
tif and is truly a Tiff image file.

MapIMG cannot read this file.

Since MapIMG works with Generic Binary files, the only way of discriminating file
types is by checking the file’s extension. Make sure the file ends in .img. A common
error is to use an ERDAS Imagine or Idrisi file, both of which also use the same
extension of .img.

Save Input Parameters — File already exists. Do you want to replace it?

This is a safeguard to protect the metadata file from being replaced if an accidental
change is made while unlocked. Click “yes” to replace the file with the new parameters
or “no” to undo all changes and revert the parameters back to how they were last saved.

MapIMG - Unable to launch web browser to ...

This error occurs when trying to access the DSS using the Tools menu in MapIMG. The

solution is to copy and paste the url to your preferred browser.
http://mcmcweb.er.usgs.gov/DSS/

The current spheroid code and/or unit code are unsupported.
The spheroid and unit code somehow became modified. This should not be possible with
the current user interface.

Pixel Size must be greater than 0.
Make sure the Pixel Size parameter for the input and output are blank or zero.

Rows and Columns must be greater than 0.

These values usually can be generated by the calculator button (=). If that doesn’t work,
then you are in either an unsupported “bad projection,” or one of the parameters is set in
such a way that the final resolution would be very close to zero (ie. True Scale of
Transverse Mercator shouldn’t be zero).

Please select a valid data type for each pixel.

Select a data type using the drop down box in the input parameters.

If you receive any other errors or unexpected results please contact the authors of
the MapIMG software package by email at mapimg@usgs.gov.
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